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Troubleshooting
Q. Wildcards do not work when the objects are set to Flags, 

Colors, or Numbers etc..
A. The Wildcards are intended primarily as a freebie for the 

animated objects setting. Wildcards can be disabled from the 
file menu

Q. Poor sound quality
A. Flip has been optimised for 32Bit Soundcards    (or higher), 

however it should still work with ANY Windows compatible 
Soundcard. 16Bit soundcards will sound sub standard 
compared to 32Bit. You also could be running a 32Bit 
Soundcard from a 16Bit soundcard driver. If this is so, carry out
the following:

1 Working from Windows explorer, go to the directory where Flip! is installed.

2 Click on any file that had a .MID suffix attached to it.

3 Windows should now play the tune using its own Multimedia player.

4 While playing, Stop the tune

5 Select Properties in the Device menu

6 and select the driver that matches your soundcard or,

7 Any driver suggesting that it is a 32Bit Soundcard driver.

Q. No Sound.
A. Check to see if you have accidentally disabled it by checking in

the No Tunes option in the File Menu. A tick indicates it is 
disabled. To enable, chick this option again and the tick will go.

Q. Intermittently Losing Sound
A. You may have other programs running that is also calling for 

the soundcard at the same time, close all programs, and restart
Flip!. Also you may be running a soundcard driver that is not 
made for use with that card.(IRQ port disconnecting, or Sound 



related instructions being sent or diverted to incorrect IRQ 
port), contact your soundcard supplier and get the correct 
driver.

Q. Is my computer too slow?
A. Unlikely, Flip! does not rely on the speed of your processor, it 

gets timing from the real time clock in your PC, however, on 
slower machines you may get slower animation and 
movement, especially if you are running early versions of 
Windows 95.

Q I have got my validation card, what do I do now?
A. Just follow the instructions on the card. It will tell you to select 

Validate in the Help menu and type in the access code 
displayed on the card, Flip! will upgrade itself, and delete any 
nag screens that were present.

Q Can I use a Portable Keyboard or sound box to play back 
Flips tunes?
Straight answer - Yes!. You will need to consult your keyboard 
owners manual on how to set it up. Flip! is programmed to 
utilise the General MIDI type format, that is, the sounds and 
their channels they are played back on are universally aligned 
for use with any keyboard that is general MIDI compatible. You 
will need to set the Windows Multimedia Player output to MIDI 
out instead of a Soundcard driver, then connect your keyboard 
to the MIDI out of your PC to the MIDI in of your keyboard.



Message from the Programmer

If you are the sort of person who goes bananas about computer games - especially strategy and
puzzle games, and have a fresh new idea or concept for one that you would like to see 
programmed, why not drop me a line?

All suggestions will be looked into, and you can even have your name in the credits if it 
suceeds. I would also be interested in hearing from anyone who has ideas for arcade type 
games, or if you owned an Atari 800 series or BBC Micro from the 1980s and had a favourite 
game. These can be re programmed for windows or MS DOS based PC. Please write to me at 
52 Hemsby Road, Chessington, Surrey KT9 2DZ UK.
Jason Bennison

Other titles include:

Doctor Lottery.
UK release only. Debug the National lottery with this super theory proving curiosity program.

Breakout32
Its fun, its fast and its free from many Internet Web Sites    BBS systems. A 32Bit reincarnation 
of the old classic from the 1980s.

And lots more to come including Minefield Many will remember my old version on the BBC 
Micro (c1981). Being developed for 32bit Windows PC at present.



Credits

Programming and Musical Adaptations by Jason Bennison
Artwork (some of it) by Belinda Bennison
Technical Consultant:    Samuel Bennison

Distributed by: JaySoft
52 Hemsby Road
Chessington
Surrey KT9 2DZ
England

Ordering Flip!

Ordering the full working edition of Flip! is simple, Just select Help / Ordering info, print the order
form and return it with payment to JaySoft and within 21 Days(World-wide delivery) you will get 
your validation card showing your access code.

You then type in the access code and BINGO! - Flip! will upgrade itself to the full working 
edition. The price includes posting and tax where applicable. The validation instructions are on 
the validation card.

Load / Print Order Form



You can order Flip! from JaySoft by payment with cheque (UK Bank or Eurocheque) or from 
anywhere in the world by Credit Card (Visa, Visa Delta, Switch or MasterCard) Flip! is supplied 
on 1.44Mb Diskette.

Name_____________________________
Address___________________________
Address___________________________
Town_____________________________
City_______________________________
Country & Zip Code__________________
Telephone_________________________
Credit Cary Type____________________
Credit Card Number__________________
Expiration Date______________________
Signature of card holder_______________

Product Cost

Flip! £14.99
Post and Packing £ Included
VAT (EC Residents) £ Included
Total £14.99

Please make cheques payable to JaySoft,
and mail to:-

Flip! Orders,
52 Hemsby Road,
Chessington,
Surrey KT9 2DZ,
England UK.

Currency exchange is carried out by the credit card automatically at the rate set by the bank that
issued the card.

Please retain a copy for your records. You should receive your order within 14 days (within 
Europe) and 28 days (World-wide)
ANV019380317



Help

Contents
Opens Flip! Help on the Contents page.

Ordering Info
Shows how you can order the full working edition of Flip!

Load Order Form
Loads and prints the Flip! Order Form.

Validate
Use this function to convert Flip! from the Shareware demo version to the fully working edition. 
Do not attempt to use it unless you have a validation card with the instructions, otherwise the 
program will terminate. You can get information on how to obtain a validation card by selecting 
Ordering Info from the Help menu. This function is disabled when Flip! is validated.

About
A small window with a bit of useless information and entertains you with a tune for good 
measure.



Objects

If you decide to change objects during a game, it will be restarted. With the exception of the first 
setting listed below where the wildcards are active, the rules of the game are the same. All of 
the options listed below showing a toolbar command button are obtainable from the toolbar.

Anything that moves
This option will display a choice of animated objects and has a wildcard option.(on by default) To
disable wildcards, select Disable Wildcards from the File Menu.

        Toolbar Control

Flags of the World
Flags of various countries are displayed along with the country name connected with that flag

        Toolbar Control

Numbers
The objects are numbers between 1 and 36, just pair the numbers together.

        Toolbar Control

Playing Cards
Uses a selection of playing cards, just need to pair them up.

        Toolbar Control

Colors (Fixed)
Uses different colored squares, the same color scheme is used each and every time this option 
is selected as the colors are generated algorithmically. There are a few duplicate pairs of colors,
so playing with this option is difficult without sound.

        Toolbar Control

Colors (Randomised)
This option is the same as the above, but the colors are generated randomly, so what colors you
get each time is anyones guess! You may even get duplicate color pairs. This option is not 
available from the toolbar.

User Words
This function is not available with the 1 player game option (Obviously!). It allows players to 
input their own word to be placed behind the shutters for their opponent to guess correctly.

Computer Generated Words (Default Setting)
This function is available with 1 and 2 player game options. Flip! will generate a word from its 
own dictionary of over 900 words and place it behind the shutters.



Skill Level

Beginner (3 x 8)
This function is available from the menu and from the toolbar. This sets the game board size to 
8 shutters wide and 3 shutters deep making a total of 24 shutters.

        Toolbar Control

Intermediate (4 x 10) (Default setting)
This function is available from the menu and from the toolbar. This sets the game board size to 
10 shutters wide and 4 shutters deep making a total of 40 shutters.

        Toolbar Control

Expert (6 x 12)
This function is available from the menu and from the toolbar. This sets the game board size to 
12 shutters wide and 6 shutters deep making a total of 72 shutters.

        Toolbar Control

1 Player Game (default Setting)
This function is available from the menu and from the toolbar. This allows only one player to 
play Flip! at any one time for any one game.

        Toolbar Control

2 Player Game
This function is available from the menu and from the toolbar. This allows 2 players to play any 
game, players may decide their opponents guess word by selecting User Word from the Objects
Menu. When a layer correctly matched any pair of objects, that player will remain in control of 
the game and is awarded another go. If you already on 2 Player Mode and wish to change the 
names of the players, select 2 player Game from the Skill Level menu again.

        Toolbar Control



File Menu

New Game
Resets Flip! and starts a new game. This function is also available from the Toolbar.

       Toolbar Control

Short Tunes    (Default)
Plays the first few bars of a tune when a shutter is selected.

No Tunes
Silence is Golden! Otherwise the same as above. With this option selected, the game is more 
difficult to play as you now have to remember the objects by their appearance only and not by 
their tunes.

Timed Game
A Continuous tune will play throughout, the game can be played faster as the game is timed (in 
seconds) and does not give a guess word prompt when objects are paired. You must clear the 
board in the shortest possible time and your best times are recorded in the Score Table. The 
Timed Game function is only available from the file menu. Wildcards are disabled.

Disable Wildcards
Wildcards, when found will allow you to open any abject shutter on the board, not just the 
second shutter of the pair. When this option is selected, a tick is placed in the menu, confirming 
that this function is active and the wildcards will not function, they will behave the same as any 
other object. To re-enable the wildcards, just select this function again and the tick is removed. 
Wildcards are enabled by default.

Score Table
Displays the current Score Table.

Exit
When Flip! is Shareware, it wil show a lillte bit of advertising and away you go. You can also Exit
Flip! from the toolbar.

        Toolbar Control



The Rule Book

You have probably played the card game SNAP! At some point in your lifetime. The concept of 
Flip! is derived from SNAP!, with a few extra twists thrown in for good measure.

You are presented with a game board with lots of Flip! shutters, you click one and it reveals an 
object. There are two of each objects on the board, and you have to pair up the objects - the 
trick is - you have to remember where the firsy object was when you find its pair. When a pair is 
matched, the objects are removed revealing a word that is partly obscured by the remaining 
shutters that have not been paired. The idea is you have to guess what the word is in as few 
attempts as possible.

When a shutter is selected, a portion of a tune is played, if the pair is matched, the tune 
continues and allows you a guess of the word revealed behind.



Overview

The great thing about Flip! is that it is easy peasy to play, but can be difficult to master!. - Just 
simply point and click! It improves your memory skills, stimulates with a variety of colors 
graphics and sound, and above all, you dont really need to able to speak English to play it!. You 
just need Windows 95 and a PC with Soundcard that can handle it. Flip! has a good overall 
educational value and is really fun to play!

Ordering the full working edition of Flip could not be easier, just select Help / Ordering Info from 
the Menu, print and return the order form to JaySoft and within 21 days (World-wide delivery) 
you will get your validation card showing your access code. You then type in the code and - 
BINGO! - you have the full working edition of Flip!. The price includes Tax (where applicable) 
and Packing and shipping.

Copies of the Shareware version of Flip! may be freely be made, distributed, given away, 
uploaded to BBS systems or sent into oblivion provided that no money changes hands (other 
than a reasonable handling charge). If you paid for this program (and the seller was dumb 
enough to include this file) then you have been done!    The full edition has a different heading 
heading on the main screen and has all the menu features enabled.




